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Digital World 6 to 8 3

Computer Studies – 6

Chapter 1 — Understanding Computers

EXERCISE

A. Fill in the blanks.

1. 0 and 1   2. Spacewar   3. MIPS    4. IQ   5. Convey

B. Write T for true and F for False.

1. F 2. F 3. T 4. T 5. T

C. Answer the following questions .

1. Computer is an advanced electronic device that takes raw data as
input from the user and processes these data under the control set of
instructions and gives the result and saves output for the future use. It
can process both numerical and text calculations.

2. A computer program is a collection of instructions that performs a
specific task when executed by a computer.

3. A computer is free from tiredness, lack of concentration etc. It can
work for hours without creating any error. It millions of calculations
are to be performed, a computer will perform every calculations with
the same accuracy.

4. Three limitations of computers are :

(i) Dependency : It functions as per user’s instructions, so it is fully
dependent on human being.

(ii) No IQ : A computer is a machine. It does not possess IQ of its own. It
cannot take its own decision.

(iii)No feelings : A computer does not have feelings or emotions.

5. Three applications of computers are :

(i) Education : We need computers to teach and learn various subjects
through multimedia CD-ROMS. Multimedia projector and power
point presentations can be used to provide quality education and
make learning fun-filled and interesting for students.

(ii) Medicine : Computers have become important part in hospitals, labs
and dispensaries. They are used to keep records of patients and
medicines. They are used for scanning and diagnosing different
diseases.

(iii)Communication : By the help of computer we can communicate to
the other person by various means such as E-mail, chatting etc.

D. Name the parts given below in the picture.

Do yourself.

Research Project

Make two lists where

(a) Computer is better than human being :

(i) Speed : No human being can compete to solve the complex
computation, faster than computer.

(ii) Storage : It can store mass storage of data.

(iii) Diligence : It can work for hours without any break.



(iv) versatility : We can use computer to perform completely different type
of work at the same time.

(v) Accuracy : It gives results with accuracy.

(b) Human being is better than computer :

(i) Unstructured problem solving : human being is better for solving for
problems in which the rules do not currently exist.

(ii) Creative thinking : Human are spectacular at several things including
pattern recognition, language abilities and creative thinking.

(iii) Non routine physical work : Performing complex tasks in 3-D space,
from cleaning to diving to cooking etc.

(iv) Expressing emotions : computer cannot express emotions. Human
beings expressing empathy, making people feel good, taking care of
others etc.

(v) Undefined phenomena : human being can only decide what is
relevant in a flood of undefined phenomena.

IN THE LAB

Do yourself

Chapter 2 — Using Windows 7

EXERCISE

A. Fill in the blanks.

1. Operating system 2. minimize 3. ellipses

4. Ripping 5. Control panel

B. Write T for true and F for false.

1. F 2. T 3. F 4. F 5. T

C. Match the following columns.

1. ……… c 2. ……… f 3. ……… d

4. ……… b 5. ……… a 6. ……… e

D. Answer the following questions.

1. An operating system is a software that manages computer hardware
and software resources and provide common services for computer
programs. It is the most important program that runs on a computer.
Every genual purpose computer must have as operating system to run
other programs.

2. When the matter contained in a window is more than its display area,
the scroll bar is required. There are two types of scroll bars as per the
matter appears in a window.

3. Notepad and calculator are two programs which consist of inbuilt
menu in windows 7.

4. Windows media player is used to play and organize digital media files
(audio and video) on a computer and Internet. We can listen to radio
stations from all over the world, play and copy CD/DVD, create our
own CD/DVD, and copy music and video to portable devices.

5. We can see the control panel in three views.

(a) Category view

(b) Large icons view
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(c) Small icons view
where category view is the default view of control panel. We can
select other views of control panel by clicking category switch
view button.

Research Project

Ans. Differences between Windows and Linux :

(i) Linux is free and open source OS whereas windows is a commercial
OS whose source code is inaccessible.

(ii) Windos is not customizable whereas Linux is customizable.

(iii) Linux provides high security than windows because Linux is open source.

(iv) Windows is user friendly in comparision of Linux.

(v) Linux was developed by Linus Torvalds whereas Windows OS was
developed by Microsoft. Windows, I like most as it is user friendly in
comparision of Linux.

Chapter 3 — More on MS Word 2010

A. Fill in the Blanks.

1. Word processor 2. Header 3. Editing

4. Thesaurus 5. text effects

B. Write T for true and F for false.

1. F 2. F 3. F 4. F 5. F

C. Match the following columns.

1. ……… C 2. ……… e 3. ……… d

4.  ……… f 5. ……… b 6. ……… a

D. Answer the following questions.

1. MS Word 2010 is an important component of MS Office 2010. We can
prepare letter, brochure, newsletter, report and web pages
comfortably. Besides maintaining test data we can prepare graphical
data with the help of various drawing tools.

2. It can consists of a title, date, page number, picture, name and
anything we desire.

3. Sometimes we need to find some word or phrase in a document. We
also need to replace this with some other text many times. It can be
executed successfully with Find and Replace commands respectively.

4. The space that comes between textual data is referred as character
spacing. We can adjust the positioning of characters by many options
of MS Word. The character spacing can be adjusted and letters can be
stretched or compressed.

5. When you read newspaper or a magazine, you would have noticed
that first character of first paragraph starts by a large capital letter. It
is referred as Drop Cap feature. It adds a decorative touch to the
document.

Research Project

Do yourself

In the Lab

Do yourself

For Teachers

Do yourself
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Chapter 4 — Mail Merge in MS Word

EXERCISE

A. Fill in the blanks.

1. Mail Merge Facility 2. tabular 3. Field

4. Mailing 5. Record

B. Write T for true and F for false.

1. F 2. T 3. T 4. F 5. T

C. Match the following columns.

1. ……… b 2. ……… d 3. ……… e

4. ……… a 5. ……… c

D. Answer the following questions.

1. MS Word provides Mail Merge facility by which we can send the same
letter to many ones but each with its specific name, address, city,
telephone number, etc. Mail Merge allows you to create letters, labels
envelopes and so on, each personally addressed to a different recipient.

2. Data source consists of mailing list, for example, name, address, city,
pin, telephone number, etc. The data is organized in tabular form
along with field names.

3. The data source is associated with the main document, so its field
names can be used in the main document and it becomes easy to
merge addresses along with the main document. Main document
consists of common text part.

4. Merge fields are inserted in main document to insert the versatile
information.

5. We can preview the letters to check that how output will come out at
the time of printing. Use following steps to preview the letters.

Before printing we should preview the merged letters. It confirms that
merged fields are picking the right data. If it is not then we will have to
check the back steps of wizard.

Click on Preview results button in the Preview Results group on
Mailings tab, or click on Next : Preview your letters (wizard step)
under ‘Step 4 of 6’ section.
The first record will be displayed. Click on Next Record button in the
Preview Results group to view the next record of the data source.

Research Project

Do yourself.

In the Lab

Do yourself.

For Teachers

Do yourself.

Chapter 5 —MS Excel 2010

EXERCISE

A. Fill in the blanks.

1. MS Office 2. searched data, replace it

3. worksheets 4. range 5. Formulas
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B. Write T for true and F for false.

1. F 2. T 3. T 4. F 5. T

C. Match the following columns.

1. ……… c 2. ……… d 3. ……… e

4. ……… b 5. ……… f 6. ……… a

D. Answer the following questions.

1. MS excel 2010 is also a component of MS Office 2010 which is
basically a spreadsheet software. Spreadsheet software is used to
calculate on numerical data. Such type of a software consists of a large
sheet in tabular format i.e. sheet is divided in rows and columns. We
can create charts and graphs from the data in Excel and convey more
meaningful information.

2. By default, an Excel workbook displays 3 worksheets at the bottom,
with the names Sheet 1, Sheet 2 and Sheet 3.

3. Famous spreadsheet softwares are visiCalc, Lotus 1-2-3 and superCalc.
These softwares were the most used softwares of their own time.

4. Cell references is the address by which any cell is identified. We can
say cell reference as cell address also.

5. If multiple cells are not adjacent then they cannot be treated as range.
Selecting such multiple cells would be done by another method.

Click on the first cell.

Hold down the Ctrl key and click in each additional cell you want to
select.

Research Project

Do yourself

In the Lab

Do yourself

For Teachers

Do yourself.

Chapter 6 —Understanding MS PowerPoint 2010

EXERCISE

A. Fill in the blanks.

1. views, ideas 2. Insert 3. microphone

4. Adding movies 5. Slide transition

B. Write T for true and F for false.

1. F 2. T 3. F 4. T 5. F

C. Match the following columns.

1. ……… c 2. ……… d 3. ……… a

4. ……… e 5. ……… f 6. ……… b

D. Answer the following questions.

1. Powerpoint is a software program that enhances oral presentation. It
operates like an old-fashioned slide show but uses modern technology
in the form of computers and digital projectors rather than a slide
projector. MS Powerpoint is a powerful tool which helps us to
communicate our views and ideas effectively using tables, diagrams,
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photos, clip arts, sounds, colours, designs and animated special
effects.

2. We can add the sound and our voice to slide. Sound can be added to a
presentation through two ways like clip organizer and file.

3. Four presentation softwares are Customshow, Clearslide, Haiku Deck,
SlideDog and Prezi Business.

4. You can animate text, graphics, charts and other objects on the slide
by the help of custom animation. In custom animation, it may be
decided that how an object will be appeared and when it will be. The
text value can be customized in Powerpoint to appear letter by letter
or word by word. The sound effect can also be added with this
animation.

5. Effect options can be used for adjusting many of the transitions. You
can choose the direction from where the slide need to be displayed.

Click on the Effect Options command on the Transitions tab.

Select the required effect from the drop-down menu.

Research Project

Do yourself

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 7 —Let Us Know QBasic

EXERCISE

A. Fill in the blanks.

1. switching, machine, language 2. QB64 3. Redo

4. constants 5. Relational 6. CLS

B. Write T for true and F for false.

1. T 2. T 3. F 4. T 5. F 6. T

C. Match the following columns.

1. ……… c 2. ……… d 3. ……… f

4. ……… b 5. ……… a 6. ……… e

D. Answer the following questions.

1. The commands or instructions in QBasic are called statements.
Various types of functions are implemented by the help of statements
in a program. The following are the statements in QBasic.

1. Assignment statement LET 2. Input statement INPUT

3. Output statement PRINT 4. REM statement REM

5. Conditional statement IF-THEN-ELSE

6. Loop statement FOR-NEXT, WHILE-WEND, DO LOOP, GOTO

2. Constants are values stored in a program which do not change during
the execution of a program. They are classified as numeric and string
constants.

Numeric constants : The numerals on which arithmetic operations can
be performed are called numeric constants. These constants have
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numbers and decimal point only. For example, 9750, 46.2, 0.67, –
425, – 0.025, etc.

String constants : Strings contain a sequence of characters in double
quotation marks. These characters may be letters, numbers and
symbols. It can also have a blank space. A double quote within a string
is not allowed.

For example, “Vineet”, “124”, “reena 67”, “2*2 = 4”, ab@329”, etc.

3. A computer performs many arithmetic operations and calculations
with the help of arithmetic operators. The basic arithmetic operators
are given here :

Operator Explanation

+ To add two or more numbers.

– To subtract two or more numbers.

* To multiply two or more numbers.

/ To divide two or more numbers.

^ To calculate Exponentiation value.

4. The operators are executed from left to right in any expression as per
the hierarchy. Hierarchy defines the order in which the operators are
executed in any QBasic expression. We use BEDMAS for the hierarchy
of operation. The full form of BEDMAS is :

B Brackets ()

E Exponentiation ^

D Division / Same Priority

M Multiplication *

A Addition + Same Priority

S Subtraction –

5. The REM statement does not get displayed in the interpreter. This
command helps to add comments or remarks to a program without
affecting its flow. These remarks are usually added at the beginning of
the program to show what the program is about.

Research Project

IF THEN Statement

This statement is used for making decision on comparisons.

IF THEN ELSE Statement

This statement is the expansion of statement IF .... THEN.

REM PROGRAM TO FIND THE GREATER NUMBER

CLS

INPUT “ENTER TWO NUMBERS;”; N1, N2

IF N1 > N2 THEN PRINT “GREATER NUMBER IS;”, N1

IF N1 < N2 THEN PRINT “GREATER NUMBER IS;”, N2

IF N1 = N2 THEN PRINT “BOTH NUMBERS ARE EQUAL”

END
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IN THE LAB

10 CLS

20 INPUT “ENTER YOUR NAME AND AGE”; NAM $, AGE

30 PRINT “My name is”; NAM $; “I am”; AGE; “years old”

40 END

10 CLS

20 INPUT “ENTER THREE NUMBERS:”; N1, N2, N3

30 SUM = N1 + N2 + N3

40 AVG = SUM/3

50 PRINT “ Average =”; AVG

60 END

Do yourself

10 CLS

20 INPUT “ENTER TWO STRINGS:”;

STR1$, STR2$

30 STR $ =  STR1 $ + STR2 $

40 PRINT STR $

50 END

For Teachers

Do yourself

Chapter 8 — More on QBasic

EXERCISE

A. Fill in the blanks.

1. human being 2. INPUT 3. Decision making

4. Pixels 5. Color command

B. Write T for true and F for false.

1. T 2. F 3. F 4. F 5. T

C. Match the following columns.

1. ……… e 2. ……… c 3. ……… a

4. ……… b 5. ……… d

D. Answer the following questions.

1. A programming language has very different properties from spoken
language. Spoken languages are used by human beings. These can be
understood in a much flexible way compared to a programming
language. A human being understand some description by many ways
because his understanding has flexible ways to process something.
Computer is a machine. It understands something through machine
language because it is a switching dead machine only.
It makes its process of understanding very rigid so a flexible slang
statement has the whole opportunity to confuse the computer. By this
reason a programming language has its specific keywords and syntax
with strict grammatical rules.

2. GOTO statement is used to transfer the program control from one
statement to another in a QBasic program.

Syntax : [Line No.] GOTO<Line No>
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3. IF THEN ELSE statement tackles the conditional statement when the
given condition is FALSE. ELSE construct will be executed in case of
condition is FALSE.

Syntax : IF <condition> THEN <statement1> ELSE <statement2>

4. The number of pixels horizontally and vertically determines the
resolution of the display. A good resolution means more pixels. The
more pixels, the clearer is the object appearing on the screen.

Resolution is specified as Column Value ×Row Value. For example,
the resolution could be 320 ×200, 640 200 640 480× ×, , 800 600×
or any other.

The most common resolution is 640 480×. You have to first set the
resolution to specify how many pixels can be displayed on the screen.

5. When simple commands are used in QBasic then these commands
show the output in black and white. The black, white and grey colours
are the default colours. If you want to show something colourful then
you will have to use COLOR command for this purpose.

Syntax

COLOR <Colour Number>

Example :

COLOR 4

PRINT “Colourful Output”

Colour mode is first changed to red colour, and then the given text will
be printed in red colour.

Research Project

Do yourself

In the Lab

10 CLS

20 N = 1; SUM = 0

30 IF N < 6 THEN GOTO 40 ELSE GOTO 80

40 INPUT “ENTER NUMBER:”; N1

50 SUM = SUM + N1

60 N = N + 1

70 GO TO 30

80 AVG = SUM/5

90 PRINT “Average is:”; AVG

100 END

10 CLS

20 INPUT “ENTER AMOUNT:”; AMT

IF AMT < 500 THEN

PRINT “ZERO DISCOUNT”

ELSE IF AMT > 500 AMT AND ≤3000 THEN

PRINT “10% DISCOUNT”

DISCOUNT = 0.1 * AMT

ELSE IF AMT > 3000 AND AMT ≤10000 THEN

PRINT “20% DISCOUNT”

DISCOUNT = 0.2 * AMT

PRINT “25% DISCOUNT”
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DISCOUNT = 0.25 * AMT

END IF

NET = AMT – DISCOUNT

PRINT “The Bill amount is:”; NET

END

CLS

INPUT “Enter the First number”; a

INPUT “Enter the second number”; b

INPUT “Enter the third number”; c

If a > b AND a > c THEN

PRINT “The greatest number is”; a

ELSE IF b > a AND b > c THEN

PRINT “The greatest number is”; b

ELSE

PRINT “The greatest number is”; c

ENDIF

END

10 CLS

20 N = 2

30 If N ≤20 THEN GOTO 40 ELSE GOTO 70

40 PRINT N

50 N = N + 2

60 GOTO 30

70 END

For Teachers

Do yourself

Chapter 9 —Internet and E-mail

EXERCISE

A. Fill in the blanks.

1. Tin Berners Lee 2. Services 3. chat

4. search engines 5. sign in, log in

B. Write T for true and F for false.

1. F 2. F 3. T 4. T 5. T

C. Match the following columns.

1. ……… b 2. ……… d 3. ……… e

4. ……… f 5. ……… c 6. ……… a

D. Answer the following questions.

1. Internet is the largest network of the world by which information is
shared to all people of the world.

2. The World Wide Web is a large computer network where by using a
browser such as Mozilla Firefox, Internet Explorer, you can surf and
get information. It consists of all the public websites connected to the
Internet worldwide, including the client devices (such as computers
and cell phones) that access web contents. The websites are identified
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by short, unique, global identifiers called URLs (Uniform Resource
Locator).

3. E-Commerce stands for Electronic Commerce, i.e., commercial
activities over Internet. Internet offers us convenient ways to shop
from our home or office for almost everything like air/rail/movie
tickets, clothes, electronic items, books, gifts etc. We can buy or sell
new or second-hand goods also.

4. We need E-mail account to use E-mail. After haivng E-mail account we
can send E-mail message to the E-mail address of the receiver. For
example, gurmindery@yahoo.com is an E-mail address, in which
gurminder is the username, yahoo.com is the domain name.

5. If you want to send a copy of the same message to some other people,
enter their E-mail addresses in Cc (Carbon copy) field.

If you went to send the same message to other people without letting
them know of the fact that others also have received the same
message, type their addresses in Bcc (Blind carbon copy) field.

Research Project

Many times we want to see something on some desired topic but we cannot
see because we do not know the name of related websites. It makes a
cumbersome situation for us. In that case Search Engines may be helpful
for us. We can find the desired subject material on Internet by the help of
search engines without knowing the exact name of websites. They can
locate any desired material like website, image, news, questions and
answers, video, etc. There are many search engines like Google, Bing,
Yahoo, etc. for which websites are google.co.in, bing.com and yahoo.co. in
sequentially. Follow these steps to search any information. Let us say, we
want to search the images of “Deforestation” on Internet.

Open any search engine say www.google.co.in. Click on the Images tab.
Type ‘Deforestation’ and click on Search button.

A list of images will be displayed. Select the image you like.

ARPANET was the first network in arisen of Internet and it was started in
1969.

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 10 —An Overview of Windows 8

EXERCISE

A. Fill in the blanks.

1. 26 October, 2012 2. start 3. New type security

4. DVD-Video 5. CHARMS

B. Write T for true and F for false.

1. T 2. T 3. T 4. F 5. F

C. Match the following columns.

1. ……… b 2. ……… f 3. ……… e

4. ……… a 5. ……… c 6. ……… d
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D. Answer the following questions.

1. On 26 October, 2012, Windows 8 released for general availability in
people. It is a personal computer operating system which is part of the
Windows NT family. Windows 8 introduced major changes to the
operating system’s platform and user interface. It improved its user
experience on tablet, where Windows is taking competition with other
mobile operating systems like Android and iOS. On 17 October, 2013
Microsoft released an upgraded version of Windows 8 which was
referred as Windows 8.1.

2. Windows 8 provides heavier integration with online services from
Microsoft and other companies. A user can now log into Windows
with a Microsoft account, which can be used to access services and
synchronize applications and settings between devices. Windows 8
also ships with a client app for Microsoft’s SkyDrive cloud storage
service, which also allows apps to save files directly to SkyDrive.

3. Windows 8 is available in three different versions and these are
Windows 8, Windows 8 Pro and Windows 8 Enterprise. Windows 8
and Windows 8 Pro were sold at retail in most countries and as
preloaded software on new computers. Each edition of Windows 8
includes all of the capabilities and features plus additional features
oriented towards their market segments. For example, Windows 8 Pro
added BitLocker, Hyper-V for taking ability to join a domain and the
ability to install Windows Media Centre as a paid add-on. Users of
Windows 8 can purchase a Pro Pack that upgrades their system to
Windows 8 Pro through Add features. The users of Windows 8 can
avail Windows Media Centre and DVD playback support by the help of
this. Windows 8 Enterprise contains additional features aimed
towards business environments.

4. Once you log in, you will see the new Windows 8 Start Screen. This
screen is agreed as the home page of your Windows 8 PC.

The Start Screen is used in windows 8 in place of start menu and is
treated as new program launcher.

The Start Screen displays tiles that represent apps, people, programs.
shortcuts and more.

You can customize and personalize the Start Screen to your tasks.

5. It is a bar which is included newly in Windows 8. You can access it by
moving the mouse pointer in the top right button corner of the screen.
It has five options, like, Search, Share, Start, Devices and Settings. If
you press Window + C keys then it can be awaken.

Research Project

Popular operating system :

l Windows 7 is the most popular operating system for desktop and
laptop computers.

l Android is the most popular smartphone operating system.

l iOS is the most popular tablet operating system.

l Variants of Linux are most widely used in the Internet of things and
smart devices.
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l Other variants of Linux are the most popular operating system on
other web servers and super computers.

Characteristics of DOS

1. It is the primary system where the user will get an environment about
the input and output deviates,e.g.,Monitor, Keyboard, Printers etc.

2. It is helpful in performing file management, e.g., creating, editing,
deleting files etc.

3. It is a single user operating system.

4. It is Character Based Interface System.

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 11 —Computer Ethics, Rights and Security

EXERCISE

A. Fill in the blanks.

1. Unethical, criminal 2. property 3. referencing

4. computer security 5. Personnel.

B. Write T for true and F for false.

1. F 2. F 3. T 4. T 5. T

C. Match the following columns.

1. ……… c 2. ……… a 3. ……… f

4. ……… d 5. ……… b 6. ……… e

D. Answer the following questions.

1. Computer ethics defines collection of rules which states for a person
what has to be done and not to be done.

2. Property is the part of property which connotes intangible creations of
the human intellect and primarily includes copyrights, patents and
trademarks. It also includes other types, moral rights and rights
against unfair competition. It is illegal to use intellectual property
without the permission of the owner or producer. The rights related to
such literary or artistic work, inventions, discoveries, etc. are called
intellectual property rights.

3. Copyright is a legal right that grants the creator of an original work
exclusive right for its use and distribution. The writers publishers will
not be benefitted in terms of money and other advantages and hence
will be less motivated for continuing the hard work to develop
material. The work of creative people must be protected by law so that
they could keep exploring, thinking and inventing in an encouraging
way. For this reason such materials are copyrighted by law.

Typically the duration of a copy right spans the authors’s life plus 50 to
100 years, i.e., copyright typically expires 50 to 100 years after the
author dies, depending on the jurisdiction.

4. Computer security is the protection of computing systems and data
that they store or access. It includes procedures and techniques that
are designed to protect a computer from accidental or intentional
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theft, unauthorized access or manipulation. Computer security is
often viewed as a disaster for the user because it can cause serious
damages to both the individual user and the organization such
damages many include loss of revenue, valuable data, productivity
and many more which may even lead to bankruptcy.

5. The people who are associated with computer crimes are often called
Hackers, crackers, virus programmers, Breahers, Information
warriors, etc.

A hacker is a person who breaks into a computer system to get illegal
access to the information stored there.

A cracker is a person who breaks into a computer system just like
hacker, with the intention to steal passwords, files or programs for
unauthorized use.

Virus programmers are like crackers who breach computer systems, in
order to steal information or cause harm to computer systems.

Research Project

Do yourself

In the Lab

Types of computer networks are :

1. Personal area network

2. Local area network

3. Wireless local area network

4. Campus area network

5. Metropolitan area network

6. Wide area network

7. Storage area network

8. System area network

9. Passive optical local area network

10. Enterprise private network

11. Virtual private network

Computer ethics in school :

(i) Breaking copyright and software theft

(ii) Hacking

(iii) Improper use of computer resources

(iv) Breaches of information privacy and confidentiality

(v) Personal information on public computers may be available for
inspection by others.

Four computer virus names are :

1. ILOVEYOU

2. Code Red

3. Melissa

4. Sasser

For Teachers

Do yourself
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Digital World – 7

Chapter 1 —History of Computers

EXERCISE

A. Fill in the blanks.

1. Computer 2. machine code 3. transistors, capacitors

4. Fourth 5. Summit

B. Write T for true and F for false.

1. F 2. T 3. T 4. T 5. F

C. Match the following columns.

1. ……… c 2. ……… f 3. ……… d

4. ……… e 5. ……… a 6. ……… b

D. Answer the following questions.

1. Abacus is treated as the first computing apparatus that was invented
in 2700 BC. Napier Bones, Slide Rule, Analytical Engine were famous
calculating machines of previous time.

2. Punched cards, paper tape and magnetic tape was used as input and
output devices.

3. The main features of second generation are :

l Use of transistors

l Reliable in comparison to first generation computers

l Smaller size as compared to first generation computers

l Generated less heat as compared to first generation computers

l Consumed less electricity as compared to first generation
computers

l Faster than first generation computers

l Still very costly

4. Some computers of Fourth generation were :

DEC 10 STAR 1000

PDP 11 CRAY-1 (Super Computer)

5. In the fifth generation, the VLSI technology became ULSI (Ultra Large
Scale Integration) technology, resulting in the production of
microprocessor chips having ten million electronic components. The
generation is based on parallel processing hardware and Al (Artificial
Intelligence) software.

6. AI is an emerging branch in computer science, which interprets the
means and method of making computers think like human beings. All
the high-level languages like C anc C++, Java, . Net etc., are used in
this generation.

AI includes :

Robotics

l Neutral Networks

l Game Playing

l Development of expert systems to make decisions in real life
situations

l Natural language understanding and generation

Digital World 6 to 8 17
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Research Project

List of super computers which are faster at world level

Sunway Taihulight—China

Tianne-2 (Milkyway-2)—China

Piz daint—Switzerland

Titan—United states

Sequoia—United states

Cori—United States

Oakforest-PACS—Japan

K computer—Japan

List of Indian Supercomputers

Pratyush (cray ×C40)

Mihir (cray ×C40)

InC 1–Lenovo C1040

SERC—Cray ×C40

In the Lab

Do yourselfl

We can use Python, Prolog, Java, C++ and LISP programmingl

languages in the field of artificial intelligence.

l Do yourself

For Teachers

Do yourself

Chapter 2 —Hardware and Software

EXERCISE

A. Fill in the blanks.

1. dead 2. hardware 3. software

4. software 5. MS world

B. Write T for true and F for false.

1. T 2. F 3. T 4. T 5. F

C. Match the following columns.

1. ……… c 2. ……… f 3. ……… d

4. ……… b 5. ……… a 6. ……… e

D. Answer the following questions.

1. Computer that it is only a dead machine and it cannot work by its own.
Human beings has to make effort for taking work by computers.
Human beings will be required to give right instructions for getting
right output from computer. Basically computer works on the
principle of GICO (Garbage IN Garbage Out).

2. ENIAC, one of pioneer computers was so large that it had occupied
two room space. Human beings needed to enter in it to work on this
computer.

3. There are numerous types of operating systems in the market like
Windows, Linux, Ubuntu, Solaris and OS/2.

4. The application software are those programs, which are written to do
our actual tasks. For example, programs written for calculating
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salaries of employees of an office, keeping account of all transactions,
printing different types of reports, maintaining the stock inventory,
preparing letters and documents, etc., are called application software.

We can ourselves develop the application software or can get it
prepared by a programmer on payment. Alternately, we can purchase
the application software from the market. In the market such
application software are generally available, with the help of which
we can do most of our tasks.

5. In Excel, we can also create charts of many types based on the data
filled in worksheets.

6. Utility softwares are used for other tasks related to a computer system.
These tasks may be removing viruses, taking backup, cleaning
garbage files and taking help for networking purpose, etc. These
utilities are also used for rectifying errors in processing and solving
our problems.

Research Project

Six input devices :

(i) Keyboard (ii) Image scanner (iii) Microphone

(iv) Pointing device (v) Sound card (vi) Video card

Six output devices :

(i) Monitor (ii) Printers (iii) Plotters

(iv) Projector (v) Head phone (vi) Speaker (S)

In the Lab

List of hardware devices

(i) Motherboard

(ii) Central Processing Unit (CPU)

(iii) Random Access Memory (RAM)

(iv) Power supply

(v) Video card

(vi) Hard Drive (HDD)

(vii)Optical Drive (e.g. DVD/CD drive)

(viii) Solid State Drive (SSD)

Importance of CPU

(i) CPU performs basic arithmetic such as addition, subtraction,
multiplication etc at at very high speeds.

(ii) The CPU makes logic decisions based on simple comparison.

(iii) The CPU “multitasks”, switching constantly among the several dozen
programs running on your PC.

(iv) A CPU spends a great deal of its time moving data from one place in
memory to another.

(v) The CPU sends signals to control the other parts of the computer.

(vi) The CPU is both the heart and brains of every computer.

l Utility software is system software designed to help to analyze,
configure, optimize or maintain a computer. Five utility softwares :

(i) Antivirus software : The software which is used to detect and
remove the malwares from our computer system is known as antivirus
software.
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(ii) Disk Defragmenter : The process which reduces the fragmented
space in the disk is called the defragmentation.

(iii)Disk Cleaner : These are the programs in built in OS to find and
delete unwanted files from the computer to free the disk space.

(iv)Compiler : For making the program executable a programming
language uses a program to transform the source code written in
programming language into machine language code is known as
compiler.

(v) Backup software : It helps in the creation of a backup of the files on
your computer. Most computer use a hard disk drive for storage.

For Teachers

Do yourself

Chapter 3 —Knowing Number System

EXERCISE

A. Fill in the blanks.

1. Aryabhatt 2. 10 3. binary

4. special 5. A, F

B. Write T for true and F for false.

1. F 2. T 3. T 4. T 5. F

C. Match the following columns.

1. ……… e 2. ……… f 3. ……… b

4. ……… c 5. ……… a 6. ……… d

D. Answer the following questions.

1. Number system is the system by which counting, arithmetic
operations are done using specific digits.

Numbers used in particular number system defines the base of that
number system.

2. Decimal number system uses ten digits. Our all numbers are makde
with these ten digits. Our most arithmetic operations are also
occurred with these decimal numbers. 10 digits are used so base of
decimal number system is 10.

3. Computer is switching machine so it understands two states only; ON
and OFF. These two states can be represented by 1 and 0 also. Binary
number system is suitable for computers because it consists of 0 and 1
only. Bi means two so it uses two digits to denote all numbers, i.e., the
base of Binary number system is 2. All digital computers use this
number system and convert the data input from the decimal format
into its binary equivalent.

4. Computer understands the alphabetic and other information like
special characters with the help of 0 and 1. This is due to American
Standard Code for Information Interchange (ASCII). It consists of 256
notations to change its binary equivalent.

5. The technique used to add binary numbers inside the computer is very
easy and simple. This is performed in the same way as you perform
addition with decimal numbers. The following table illustrates the
addition of two binary digits.
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a b a + b = c

0 0 0 + 0 = 0

0 1 0 + 1 = 1

1 0 1 + 0 = 1

1 1 1 + 1 = 10

When we add two binary numbers they carry over 1 is shifted to the
next place as it happen in decimal number addition.

For example

Compute ( ) ( )1010 1012 2+
1010

+ 0101

1111

Research Project

Do yourself

In the Lab

(i) Number system : A number system is a collection of various sysmbols
which are called digits.

(ii) Different types of number system

1. Binary number system

2. Decimal number system

3. Octal number system

4. Hexadecimal number system

(iii) Numbers used in particular number system defines the base of that
number system.

(iv) Computer arithmetic can also be done using these number system.

(v) Decimal number system is the most common number system.

Octal addition can be done just as we do number in any base.

(i) Octal digits range from 0 to 7.

(ii) Add two corresponding digits. If the total exceeds 7 then subtract 8
from the result and then “carry the 1” that means add 1 to the digit to
the left.

For Teachers

Do yourself

Chapter 4 —Windows 7

EXERCISE

A. Fill in the blanks.

1. Operating system 2. Library 3. control panel

4. Fonts 5. Sticky keys

B. Write T for true and F for false.

1. T 2. F 3. T 4. F 5. F

C. Match the following columns.

1. ……… c 2. ……… e 3. ……… d

4. ……… f 5. ……… b 6. ……… a

Digital World 6 to 8 21



D. Answer the following questions.

1. Windows 7 is the most popular operating system of the world and it is
due to many remarkable facilities to end user, specially in the field of
data management. Here Documents folder and Windows Explorer is
used to locate your files and folders. Documents folder is more
convenient for viewing a folder or window at a time. Files are viewed,
explored and organized by Windows Explorer in a computer. We can
see the directory structure through Windows Explorer. That structure
includes drives, folders and files.

2. Click on Start > Open Windows Explorer

or

Click on Start > All Programs > Accessories > Windows Explorer

The window of ‘Windows Explorer’ is divided into two panes left and
right. The left pane displays the disk drives and folders in a
hierarchical order.

The right pane displays the contents of drive/folder that is selected in
the left pane.

3. Control Panel enables you to make changes in the appearance and
current settings of Windows. It is a system folder. Control Panel
includes the following options.

Appearance and Personalization of the desktop.

Hardware and Software Set up and Configuration.

System and Security.

Networking and Internet.

User Accounts and Family safety.

Setting Clock, Language and Region.

These settings control nearly everything regarding Windows looks
and works. They allow you to set the Windows in a desired way.

4. Use the following steps to use on-screen keyboard with the help of
mouse.

Open application/program in which you want to use keyboard.

Select Start > All Programs > Accessories > Ease of Access and Click
on On-screen Keyboard option.

A virtual keyboard will be displayed on the screen as given in the
figure below.

Click on the desired key buttons and application/program will take it
as key suppressions.

5. You can follow these steps to activate the feature from Windows :

Select Start > Control Panel > Ease of Access > Ease of Access Centre

Select Make the keyboard easier to use option. Activate Turn on Sticky
Keys by clicking on the checkbox.

Click on OK to apply the setting.

6. Following these steps to put your computer in sleep mode.

Select Start > Control Panel.

Click on System and Security option of category. Click on Power
Options category appeared window.

Select the Power saver option, Sleep mode will become active. To
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make further changes, click on Change plan settings option and select
the desired settings.

Research Project

A better way to minimize all your windows with one click is to click the
show desktop button located at the extreme right side of the taskbar. Five
differences between windows 7 and windows 8.

l When you log in to windows 8, the first screen you see is the new ‘Start
Screen’ which has tiles while in windows 7 we have icons.

l Windows 8 comes with an antivirus program called ‘Defender’.

l Windows 8 doesn’t have a start Menu. Instead it has a ‘chairs bar’ which
is where you go to shut down and we other tools such as ‘search’.

l Windows 7 has good gaming platform whereas windows 8 is not
recommended for games.

l Windows 7 uses basic internet explorer for browsing whereas
windows 8 has updated internet explorer.

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 5 —Formula and Functions in MS Excel

EXERCISE

A. Fill in the blanks.

1. = 2. Constants 3. Cell references

4. SQRT (number) 5. Insert function

B. Write T for true and F for false.

1. T 2. T 3. F 4. T 5. T

C. Match the following columns.

1. ……… d 2. ……… a 3. ……… e

4. ……… f 5. ……… b 6. ……… c

D. Answer the following questions.

1. MS Excel provides a large range of facilities to manipulate and analyze
numerical data. Formula is one of them. Formulas are used to perform
all arithmetic calculations which involve two or more cells. Formulas
are used to perform addition, subtraction, multiplication and division.
A formula is an expression that uses cell address, number, arithmetic
operator and parenthesis. We can perform simple and complex
calculations using Functions. Formula must begin with ‘=’ symbol
followed by cell references and operators.

2. Compound formulas are used when you need more than one operator.
For example : to calculate the Simple Interest using the formula
‘P*R*T/100’.

3. Text values can also be used in Formulas and these can consist of all
alphabetic characters, numeric values and special characters.

These values can be added or concatenated. The text value are
enclosed in double quotes. The symbol and (ampersand) is used to do
concatenation.
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For example : typing = “Amar” and “Sharma” in the formula bar will
produce the result as Amarsharma.

4. Mixed reference is a reference that refers to a specific row or so
column. It is used when only either only row or only column is being
changed. Both approaches are used so it is referred as mixed
reference. A good example of mixed reference is multiplication table.

5. An Excel Workbook consists of three worksheets by default named as
Sheet1, Sheet2 and Sheet3. We can put name to an existing or new tab
according to following steps :

Right click on the ‘Sheet2’ tab in the worksheet.

A popup menu appears. Select the Rename option.

Cursor will be appeared in tab. Type the desired name like good_sheet
and press the Enter key.

You will see that name of sheet has been changed.

6. Functions are used to perform calculations using arguments.
Arguments show the used cells in a particular order. These functions
eliminate the chance to write wrong formulas. After process on
arguments functions return values. The values related to arguments
are given within parenthesis.

A function always starts with equal sign (=) followed by the function
name. Arguments are specified within parenthesis and these are
separated by commas. Example : The SUM function takes the sum of
two numeric values entered in other cells of worksheet.

Research Project

There is IF decision making function used in excel :

(i) The IF function.

(ii) It uses the following relational operators : is equal to, is greater than

We can show some numeric values with currency symbol.

On the Home tab, in the Number group, click Accounting number
Format. If you want to show a currency symbol other than the default,
click the arrow next to the accounting number format button and then
select another currency symbol.

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 6 —Analyzing Data in Excel

EXERCISE

A. Fill in the blanks.

1. Excel 2. Category axis 3. column

4. sorting 5. Filtered

B. Write T for true and F for false.

1. T 2. T 3. F 4. T 5. F

C. Match the following columns.

1. ……… c 2. ……… d 3. ……… b

4. ……… e 5. ……… a
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D. Answer the following questions.

1. Excel has large potential about analyzing data through many facilities.
These facilities are not only textual but also graphical. Data can be
sorted, filtered in Excel besides making charts. Charts can be of many
types to show the data in graphical way. Graphical representation are
more easier to understand compared to a textual information. Charts
provide more accurate analysis of information.

2. Charts are pictorial representations of data. They are used for
analyzing the data. When a user changes the data, chart automatically
changes. It allows to see the effect of problem after change in data.
The trends and relationships between series of numbers can also be
studied with the help of charts.

3. The various components of a chart are :

(i) Chart Area.  (ii) Category Axis.  (iii) Value axis. (iv) Legend

4. Different types of charts are available in Excel. They are Column, Bar,
Line and Pie charts.

5. When user arranges the given data according to a particular field
either in ascending order or descending order then it is referred as
sorting data.

6. It filters the selected cells of worksheet according to the selected values
of a column. You should used the following steps to use Auto Filter.

Click on the Data tab.

To apply a filter to a range of cells, first select the cells. Then, click on
the Filter option the Sort and Filter group.

An arrow appears in each column heading. Select the desired value
and filtering criteria after clicking the arrow in a column heading. The
data is filtered on that value. That is, only the rows containing the
selected value are displayed.

Research Project

Do yourself

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 7 —Learning QBasic

EXERCISE

A. Fill in the blanks.

1. GIGO 2. BASIC 3. John G. Kemeny and Thomas E. Kurtz

4. Color 5. LINE 6. ellipse arc

B. Write T for true and F for false.

1. F 2. T 3. T 4. T 5. T

C. Match the following columns.

1. ……… d 2. ……… c 3. ……… f

4. ……… e 5. ……… a 6. ……… b

D. Answer the following questions.

1. Programming languages is the media by which human being gives
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instruction to the computer. Programming languages are of many
types. BASIC is a language invented in 1964 which is used by
beginners mostly. Its constructs are easy and increases logical learning
of user. If one learns BASIC perfectly then learning other language is
not a cumbersome task.

2. The value of Constant is remain unchanged during whole execution of
program. These are of two types. Numeric constants and character
constants.

A variable is a meaningful name of data storage location in computer
memory. It holds the value and continue until another value is
assigned to it. A variable has a type, which is defined by the kind of
value it holds. It is of two types Numeric variable and string variable.

3. A comma displays different elements of the output at a gap of
approximately 8-10 characters.

Syntax : PRINT <Text>, <Text>

If there is a comma after the text (“Amit”) and a new PRINTcommand
is written after the comma (PRINT “I live in Delhi”), the output of
second PRINT command starts from the previous line after leaving a
space of 8-10 characters.

4. IF THEN STATEMENT : is used for making decisions based on the
result of comparison. The IF command has to be followed by THEN
command and lastly END IF construct.

Syntax : IF <CONDITION> THEN <STATEMENT> END IF

If the condition is TRUE, then the instruction(s) specified after
“THEN” is executed. If the condition is FALSE, the control shifts to the
ENDIF ignoring everything after the THEN statement on that line.

IF…THEN…ELSE STATEMENT : is also a conditional decision making
statement which executed something else when condition is false. If
the condition is false then the construct after ELSE part will be
executed.

Syntax : IF <Condition> THEN <Statement> ELSE <Statement2>
END IF.

5. DRAW statement is used to make drawing from a fixed point which is
set with PSETcommand. A creater can move around the screen by the
help of this and draw straight lines in eight directions without
specifying any pixel coordinates.

Syntax : DRAW <Direction string>

Research Project

REM FIND SUM OF 10 INPUT NUMBERS

CLS

SUM = 0

FOR I = 1 TO 10

INPUT N

SUM = SUM + N

NEXT I

PRINT SUM

END

Equivalent Flow Chart
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In the Lab

CLSl

INPUT " Enter your name"; NAME $

INPUT " Enter your age"; AGE

INPUT " Enter your class"; CLASS $

PRINT " Your name is : "; NAME $

PRINT " Your age is : "; AGE

PRINT " Your class is : "; CLASS $

END

l CLS

INPUT "Enter the string" ; STR $

IF STR $ = "Hello" THEN

PRINT "Right Password"

ELSE

PRINT "Wrong Password"

END IF

END

l SCREEN 7

COLOR 5, 14

CLS

PRINT "Circle in QBASIC"

CIRCLE (100, 100), 50, 1

END

PLAY “e8 d8 c8 d8 e8 e8 e4”

PLAY “c8 d8 e8 f8 g8 a8 b8 c4”

END

For Teachers

Do yourself

Chapter 8 —Repeating Tasks in QBasic

EXERCISE

A. Fill in the blanks.

1. Loops 2. FOR…NEXT 3. one

4. nine 5. WHILE 6. DO…LOOP WHILE

B. Write T for true and F for false.

1. T 2. F 3. F 4. T 5. F

C. Match the following columns.

1. ……… c 2. ……… d 3. ……… a

4. ……… b 5. ……… f 6. ……… e

D. Answer the following questions.

1. QBasic offers mainly four types of loops t repeat the tasks. Loop is a
repetition technique where a counter variable is used to count the
number of tasks. It is initialized with some start value and
incremented by 1 after each iteration. It is compared with total
repetition value when an iteration completes the counter variable’s
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value will be equal to total repetition value and the loop will be
terminated.

2. Purpose of Flow Chart

1. It provide people with a common language or reference point
when dealing with a project or process.

2. People use Flow charts to represent ideas in a graphical manner.

3. FOR…NEXT is the most popular loop of QBasic due to its
advantageous construct. It is agreed as the most time saving
command. It saves both programming and processing time. This loop
is generally used when user exactly knows the number of iterations
before executing the loop. The process of repeating a program
segment in a loop can be simplified and controlled by using
FOR…NEXT statement.

4. When FOR…NEXT statement is used within another FOR…NEXT
statement then it is known as Nested FOR…NEXT loop. The loop
which encloses another loop is referred as outer loop and another loop
is referred as inner loop. You can have, levels of nested loop i.e., loop
in loop in loop…9 times.

5. Many times we want to run a loop while a condition remains true. In
such case WHILE…WEND statement is used.

Syntax : WHILE <condition<

{Statements to be repeated}

WEND

6. Many a times you want to run a loop minimum one time irrespective
of loop condition. After running one time loop checks the condition
and repeats the task till condition remains true. DO…LOOP WHILE
statement is used for this purpose.

Research Project

CLS

INPUT “ENTER ANY NUMBER”; N

C = 0

FOR I = 1 TO N

IF N MOD I = 0 THEN C = C + 1

NEXT I

IF C = 2 THEN

PRINT N; “IS PRIME NUMBER”

ELSE

PRINT N; “NOT A PRIME NUMBER”

END IF

END

In the Lab

CLS

INPUT “ENTER ANY NUMBER”; N

IF N MOD 2= 0 THEN

PRINT N; “IS EVEN NUMBER”

ELSE

PRINT N; “IS ODD NUMBER”
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ENDIF

END

10 CLS

20 INPUT “ENTER YOUR NAME :”; NAME $

30 INPUT “ENTER YOUR SURNAME :”; SURNAME $

40 FULLNAME$ = NAME$ +“ ” + SURNAME$

50 PRINT “FULL NAME IS : ”; FULLNAME $

60 INPUT “Do you want to continue; press Y or N”; CHOICE$

70 IF CHOICE$ = “Y” GOTO 20 ELSE GOTO 80

80 END

CFLS

INPUT “enter a number”; n

WHILE n < > 0

r = n MOD 10

s = s + r

n = INT (n/10)

WEND

PRINT “The sum of digits =”; S

END

For Teachers

Do yourself

Chapter 9 —Adobe Photoshop

EXERCISE

A. Fill in the blanks.

1. Adobe Photoshop 2. Bitmap, vector 3. photoshop

4. Magnetic Lasso 5. Color palettes 6. Stamp

B. Write T for true and F for false.

1. T 2. T 3. T 4. F 5. F

C. Match the following columns.

1. ……… d 2. ……… a 3. ……… e

4. ……… f 5. ……… c 6. ……… b

D. Answer the following questions.

1. Adobe Photoshop is image creating an editing software which
provides mass facilities to perform image creation and manipulation.
Adobe is the name of company which has created this software. You
can edit and manipulate the colour, brightness and contrast of
photographs in a easy way and without any loss in quality. You can
create the image file of less size which can be shared, loaded and
opened in less time. The three dimensional pictures can also be
created in Photoshop. You can remove unwanted parts of drawing.

2. Bitmap images are made up of pixels which are tiny squares in real
while.

Vector Images are made up of lines and curves. Mathematical objects
that are used to describe these are called vectors. A vector image can
be easily made larger or smaller without any loss in quality. This is
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because a vector image is made up of mathematically defined objects,
rather than by a pattern of pixels.

On the other hand, since Bitmaps are made as the size of a bitmap,
requires a complete rearrangement of these pixels, changing pixels.
Hence, enlarging these images always results in a loss of quality,
making them appear blurry or even pixelated.

3. You can select the parts of the object with magic word tool. Parts
should have same colour. You should use the following steps to use
this tool.

Select the tool by clicking it.

Hold Shift key and click on the parts of object. As you click more, you
select more parts of object. You can select a part of object with one
click.

4. Lasso Tool allows the free-hand selection of a part or the entire image.
There are three types of Lasso tools. These are Lasso tool, Polygonal
Lasso tool and Magnetic Lasso Tool.

5. Objects can also be drawn in Photoshop like Paint with the help of
drawing tools. Right click on the Shape tool to get the related tools.

A drop-down menu will be displayed. User can select the desired tool
to draw the shape from it.

6. Gradient Tool gives different shades to the background. These can
either be used with different shades of one colour, or a combination of
many colours.

Research Project

Adobe Flash Player is computer software for using content created on the
Adobe Flash platform, including viewing multimedia contents, executing
rich internet applications and streaming audio and video. It can run from a
web browser as a browser plug – in or on supported mobile devices. It was
created by Macromedia and has been developed and distributed by Adobe
systems. Flash Player is distributed as freeware or in china, as adware.

Advantages

(i) Cross-browser compatibility

(ii) Image replacement for special fonts

(iii) Interactivity

(iv) Better expression through Animation

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 10 —More About Photoshop

EXERCISE

A. Fill in the blanks.

1. Photoshop 2. pre-loaded 3. 1988, John knoll

4. Layers Palette 5. Filters
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B. Write T for true and F for false.

1. F 2. T 3. T 4. T 5. F

C. Match the following columns.

1. ………c 2. ……… e 3. ……… b

4. ……… a 5. ……… d

D. Answer the following questions.

1. Photoshop provides large facilities to users. (i) We can use custom
shape tools to incorporate desired shapes in your files. (ii) Special art
effects can be applied.

2. Custom shape tools are pre-loaded shapes to generate desired
outcome.

3. ADVANTAGES OF WORKING IN LAYERS

By using layers, it becomes very easy to separate parts of an image and
edit one part without affecting the other parts.

Layers can be used for reference and we can avoid including them in
the final image.

Working in layers helps you to move the new image around, resize it,
and do whatever you like without affecting the original image.

One can easily create multiple versions of a layer and try out different
effects in each layer. This helps in keeping the original image intact
while making a separate layer to work with.

4. Layers Palette is used to manipulate layers by all aspects. It lists all the
layers and layers effects in an image. We can select, rename and view
layers by the help it. We can add, hide, link and delete layers with its
various tools.

5. Using Layers Menu by selecting Layer from the menu bar. Select
Arrange option from the appeared menu. A sub-menu will be
appeared. Select the related menu option to change the order of
desired layer.

6. Filters are also important part of Photoshop. Filters are used to clean
up or retouch photos, apply special art effects, add light effects and
distort or transform images. All built-in-filters from Adobe are
contained in Filters menu.

Research Project

Do yourself

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 11 —Using Internet

EXERCISE

A. Fill in the blanks.

1. Internet 2. WWW 3. microblogging

4. Larry Page, Sergey Brin 5. Virus 6. Antivirus software

Digital World 6 to 8 31



B. Write T for true and F for false.

1. T 2. T 3. T 4. T 5. T

C. Match the following columns.

1. …… c 2. …… f 3. …… e 4. …… a 5. …… b 6. …… d

D. Answer the following questions.

1. Michael Bauer is the owner of Internet.

2. A blog is an easy-to-create website that allows users to share their
thoughts with the world. The word “blog” comes from “Weblog”
because a blog consists of a signed and dated log of individual
postings. The topic of the blog can be anything, from personal to
professional.

3. Every E-mail program provides an address book by which E-mail
addresses can be stored.

4. A newsgroup is referred to cyber community which is dedicated to the
discussion of a particular topic of interest. Current events are nearly
referred as newsgroups. These topics may be from computers to
research, politics to humanities, etc. You can join any time a
newsgroup and become part of a huge conversation between
thousands of people.

A mailing list is a system by which a group of people can have a
discussion via e-mail. The idea is that a person can send a message to
one central address. That message is then processed by a program
which automatically sends a copy of the message to each subscriber on
the list in the form of e-mail message. Subscribing and unsubscribing
to mailing list is easy. Each list has a special administrative address.
You have to send only a message to that address saying that you want
to subscribe or unsubscribe.

5. SPYWARE is also a type of malware that is installed on computers and
collects information about users without their knowledge. Spyware
monitors secretly various activities of users and can collect various
information about users such as internet surfing habits, visited web
page, etc. It sends this information in background to someone else.
Sometimes these programs change the internal settings by which
connection speed becomes slow and programs execute in wrong way.

6. Four antivirus programs are :

Norton Antivirus, McAfee Virus Scan, AVG Antivirus and PC-Clilin.

Research Project

1. Gandcrab Ransomware : Gandcrab is ransomware spread through
malvertisements, explicit websites, or spam emails, which lead the
user to Rig Exploit kit Page. Once ransomware is active on the
system, it starts to gather user’s personal information such as
username, keyboard type, OS version etc.

2. Magniber Ransomware : Magniber is spread through malvertisements
infected websites that redirects user to Magnitude exploit kit page. It
starts encrypting the data and files wiht the use of a unique key.

3. Thanatos Ransomware : It’s a new computer virus named ‘Thanantos’,
which is distributed through malvertisements, spam emails with
malicious attachments and file types etc. The most complicated part is
to decrypt the data been encrypted by this ransomware.
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In the Lab

Do yourself

For Teachers

Do yourself

Chapter 12 —A Sight on Windows 10

EXERCISE

A. Fill in the blanks.

1. Windows 10 2. upgraded 3. Bitlocker

4. plain-vanilla 5. Cortona 6. Shut down, restart

B. Write T for true and F for false.

1. T 2. F 3. F 4. F 5. T

C. Match the following columns.

1. ……… c 2. ……… d 3. ……… b

4. ……… f 5. ……… a 6. ……… e

D. Answer the following questions.

1. Windows 10 is an operating system for personal computers, tablets,
embedded devices and internet devices.

2. Organizations and users can pick and choose how they will patch and
update Windows 10. Users can access a Windows 10 upgrade through
the Windows Update Assistant to manually being an upgrade or wait
for Windows Update to offer an upgrade when it is set to run.

3. 16 GB for 32-bit OS, 20 GB for 64-bit OS is required for running
windows 10.

4. Cortona shows up in Windows 10 as a search pane on the taskbar. It is
also referred as the Windows Phone Assistant. We can trigger it by
saying ‘Hey Cortana’ when you start searching the Start menu. We can
search it and locate apps we have, installed, document we have access
to, apps we could install from the store, search results from the web
and a range of other information including from apps and services
that integrate with Cortona.

5. We can resize the command prompt window in Windows 10. We can
use familiar keyboard shortcuts to copy and paste at the command
prompt.

6. Restart through the Start Menu.

Step 1 : Tap the lower-left Start button to open the Start menu.

Step 2 : Click the Power Options button on the top middle and select
Restart in the list.

Research Project

Do yourself

In the Lab

Do yourself

For Teachers

Do yourself
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Digital World –  8

Chapter 1 — Networking in Computers

EXERCISE

A. Fill in the blanks.

1. Computer network 2. clients or nodes. 3. Transmission media 4. Router

5. WAN  6. Star

B. Write T for true and F for false.
1. T  2. T 3. F  4. T  5. F

C. Match the following columns.

1. — c   2. — f  3. — d  4. — b  5. — a  6. — e

D. Answer the following questions.

1. ATM is a device that is related to computers of bank. Any person can
withdraw money from ATM then this transaction will be equivalent to
a situation where one person withdraw money from Teller in bank
office personally.

2. Many times several computers are connected to a big computer, in
such a way as all computers can communicate with each other
through the main computer. In this condition, the main computer is
called the server and all the remaining computers are called clients or
nodes. All these computers are collectively called a workgroup. Such
networks or workgroups are quite common these days.

3. A network card is used to attach a computer physically to network.
NIC is also referred as LAN card or Ethernet card. By the help of this
computer can participate in network communication. Now a days
most of the computers come within inbuilt card.

4. Router Gateway

Router is a device used to connect two
non-identical networks. It is used to
route the data across different parts
of the network when the computers
are connected in WAN (Wide Area
Network). Routers are generally
classified to two types : Static routers
and dynamic routers.

Gateway is a device used to
connect two dissimilar
LANs. It is required to
convert data packets from
one protocol format to
another before forwarding
it.

5. LAN

(i) It is designed for a small area (maximum up to  1 kilometer).

(ii) It supports less number of users. However different LANs can be
connected together to increase the number of users.

(iii) Generally a single person or single organization owns LAN.

(iv) It requires relatively inexpensive communication media. It does
not require special device like modem, repeaters, etc.

(iv) It provides quite high data transmission rate.

MAN

(i) It is designed for a mid-sized area (maximum up to 80
kilometers).

34 Digital World 6 to 8

Computer Studies –



(ii) It supports more number of users.

(iii) Owner may be a single person or group of many persons.

(iv) It requires expensive communication media like fibre or
microwave. Many times it requires special devices like modem
and repeaters.

(v) It also provides a high data transmission rate.

6. Every computer in this topology is connected to its nearest computer
in such a way that entire system forms the shape of ring. A special
signal token travels around the ring visiting every node and provides
chance to every node to transmit data. This token indicates that line is
ready and free to send data. A node can send its data when it gets this
token. The communication path may be unidirectional or
bidirectional.

Research Project

System Bit Rate

(i) Telephone twisted pair 33.6 – 56 kbps

(ii) Ethernet twisted pair 100 Mbps, 10 Mbps

(iii) Cable Modem 500 kbps – 4 Mbps

(iv) Optical Fiber > 1600 Gbps

LAN can be used for a small area.

In the Lab

Do yourself.

For Teachers

Do yourself.

Chapter 2 — MS Access 2010

EXERCISE

A. Fill in the blanks.

1. data 2. dBase, Fox Pro 3. Tables 4. Reports 5. As the name suggests, it
6. Primary key

B. Write T for true and F for false.
1. T  2. T 3. F  4. T  5. F

C. Match the following columns.

1. — b   2. — c  3. — f  4. — a  5. — d  6. — e

D. Answer the following questions.

1. Data is considered as raw facts, information is interpreted as prepared
outcome, or we can say information is prepared after processing of
data in desired direction. Data can be agreed as a source of
information also.

2. There are three types of DBMS.

Hierarchical DBMS : A DBMS is said to be hierarchical DBMS,
when the data is organized like a tree structure. It simply represents
the data using parent-child relationship.

Network DBMS : A DBMS is said to be Network DBMS, when it
organizes the data in a network structure. A Network DBMS will have
many-to-many relationship.
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Relational DBMS : A Database Management System is said to be
relational if it is based on Relational model. A relational database is a
collection of data organized and described in terms of related tables
from which data can be accessed easily.

3. A relational database stores vast amount of data, but queries help us
to retrieve the filtered data based upon some conditions. Queries are
also used to perform actions, such as delete, update, etc., on the data,
based upon some criteria (conditions).

4. Some popular RDBMS are Ingers, Informix, Oracle, Visual FoxPro and
Sybase.

Specialities of MS Access

5. (i) A large information is broken into smaller parts so that it can be
easy to access the information.

(ii) Access provides the sharing of data. Various users can access the
information according to their needs from the same database.

(iii) Access provides a great security towards data and maintains
integrity. So that data can be consistent and reliable.

(iv) Data redundancy (Duplication of Data) is reduced in MS Access.
It is done through relationship using common fields in tables.

6. One of the easiest ways to create a table is to use a template. A
template is a ready-to-use database that contains various types of
tables, queries, forms, etc. needed to perform a specific task.

Research Project

Creating form for entering data in tables of database

Select the table or query for which you want to create form.

(i) Click on the create tab on the Ribbon. Select the form option in the
forms group.

(ii) A new form is created and opens in Layout view, in which you can
change the appearance of a form. You will notice that three new tabs :
Design, Arrange and Format appear in the Ribbon.

(iii) If you want to edit or enter data in the form, click on the Home tab >
View button > Form View.

(iv) Use the Record Navigation bar to move through the records in the
form.

(v) After finishing the data entry, save your work by clicking on the Save
option in Quick Access Toolbar or the Save option in the File tab. You
will observe that the Form object gets added in the Navigation Pane.

In the Lab

Do yourself.

For Teachers

Do yourself.

Chapter 3 — Tables in Access

EXERCISE

A. Fill in the blanks.

1. cell 2. Data types 3. Auto number 4. design 5. datasheet 6. Shift + Tab
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B. Write T for true and F for false.
1. T  2. T 3. F  4. T  5. T

C. Match the following columns.

1. — e   2. — d  3. — b  4. — c  5. — f  6. — a

D. Answer the following questions.

1. A field is the collection of information of one type for all entities
related to table.

2. Memo field : Stores text and numbers up to 65,536 characters. It is
used for descriptive fields.

3. We should follow these steps to save a table’s records.

(i) Click on Home tab.

(ii) Click on Save button of Records group.

4. Deleting Field in a Table : We can delete the field from table using
following steps.

(i) Select the column by clicking on the column header and press the
Delete key or right click on the column and select the Delete Field
option from the context menu.

(ii) A dialog box appears, asking for your confirmation. Click yes to
confirm the deletion. Click No if you want to cancel the deletion.

5. Deleting Field in Structure of Table : We can delete a field in
design view using the following steps.

(i) Select the field which you want to delete.

(ii) Click on the Delete Rows option on Tools group on the Design
tab.

(iii) MS Access will display a warning box that will confirm you to
delete the field permanently. Click on Yes button.

(iv) The field will be deleted from the table.

6. Sorting Data in a Table : We can sort data within a table with
respect to a particular field either in an ascending or descending
order. To sort the data, follow the steps given below :

(i) Select the field that you wish to sort.

(ii) Click on the drop-down arrow next to the right of the field.

(iii) Select either Sort Smallest to Largest or Sort Largest to Smallest
option from the drop-down list. Observe the change in the
database.

Research Project

Do yourself.

In the Lab

Do yourself.

For Teachers

Do yourself.

Chapter 4 — Working with Queries and other Components

EXERCISE
A. Fill in the blanks.

1. Query  2. logical  3. five 4. common 5. query wizard, query design

6. form
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B. Write T for true and F for false.
1. T  2. F 3. T  4. T  5. T

C. Match the following columns.

1. — c   2. — a  3. — d  4. — f  5. — b  6. — e

D. Answer the following questions.

1. A Query is a database object that helps to retrieve and view
information from anyone or more database tables that meet a specific
condition or criteria we define.

2. Let us take an example. In the student info table, we have records of
class XII as well as class X students. Suppose we want to extract the
records of only class XII students, or the records of class X students
scoring more than 90 marks; we can find this with the help of queries.
Queries are made on tables and the result of a query is also displayed
in form of a table. The result we get is a group of rows and columns
with the set of records that matches the given condition.

3. Relationships are used to access data from more than one tables.
These tables are used to link on the basis of some common field, after
that these can be accessed together. After defining relationship
between tables, data from two or more tables can be used by Query,
Form and Report. Relationship works on the basis of matched values
from used tables for common field(s). When a relationship is set
between two tables, there is a chance to use primary key in one table
and foreign key in another table. Primary key identifies unique
records in table while foreign key has the value to match the primary
key of another table.

4. The tables selected for query displays their fields. We can select
desired fields of these tables to make query. Double click on the field
or drag field of table to Design Grid located at lower part of window.
Added fields will decide the size of information.

Or property is used to set multiple criteria in a query.

5. Geting Query output by specifying the multiple criteria :
We can specify more than one conditions to specify multiple criteria.
We should follow the given steps to specify multiple criteria.

l Suppose you want to see the records of students who live in
Ghaziabad and Panchkula. Move the cursor to the Criteria row and
type the condition = "Ghaziabad" in City field. Type another condition
= "Panchkula" in Or row of the same column.

l Save the query and click on the Close button.

l Now run the query to see the output.

6. Access provides three main views in which a form is displayed.

l Form View is used to enter or edit data. Data can also be viewed on
it. is used to adjust the design of form. It gives you a more

l Design View
detailed view the structure of form.

l Layout View is used to change the look and feel of a form.

Research Project

Do yourself
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In the Lab

Do yourself

For Teachers

Do yourself

Chapter 5 — Adobe Photoshop CS6

EXERCISE

A. Fill in the blanks.

1. Adobe Photoshop  2. Thomas Knoll  3. Tools Panel 4. Resolution

5. Lasso  6. crop

B. Write T for true and F for false.
1. T  2. F 3. T  4. T  5. F

C. Match the following columns.

1. — c   2. — d  3. — f  4. — e  5. — a  6. — b

D. Answer the following questions.

1. Adobe Photoshop is the full name of Photoshop software and it is a
graphics editing program developed by Adobe Systems. Photoshop is
widely used by millions of graphics artists, web developers,
photographers as well as common people. Most of the posters,
magazine covers, book covers, brochers, etc. have been created or
edited with Photoshop. Because of the popularity of this software, it
has been agreed as the legacy among its users.

2. Features of Photoshop CS6

There are numereous features of Photoshop that make it a unique and
sound skilled software.

l It has revised user friendly interface.

l It can do photo editing and photo manipulation in less time and with
little effort.

l It has powerful tools to enhance or change the colour of an image by
adjusting the brightness and contrast, colour balance, hue and
situation levels, and curves, etc.

l Layer effects preserve the original state of an image while
manipulating another version of it through another layer. We can add
as many layers as we need.

3. Workspace contains the image that you want to edit. It is also known
as image window or document window.

4. The name of any four selection tools are Marquee tools, Lasso tools,
Crop tool and move tool.

5. Different Marquee tools are :

l Rectangular Marquee Tool : To make a selection in a rectangular
shape.

l Elliptical Marquee Tool : To make a selection in an elliptical or a
circular shape.

Single Row Marquee Tool : To make a selection as a row.

Single Column Marquee Tool : To make a selection as a column.
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6. The Crop Tool is used to select a desired area that you want to
emphasize and removes all unselected area. We should follow these
steps to select the area using Crop Tool.

l Open the desire image that you want to crop.

l Photoshop places a crop box automatically and shows the dotted line
around the image.

We can crop the part of the picture using anyone of given two ways.

l We can drag the handles to confirm the desired part of image.

l We can drag the mouse to confirm the desired part of image.

After selecting area, we will see the area outside cropped area as dark.

l We should press the Enter key or click on the Commit button in the
context menu to remove the unwanted area of image, i.e., crop the
image.

l We can press the Escape key or click the cancel button in the context
menu to cancel the cropping.

E. Label the Tools panel of Adobe Photoshop CS6 given below.

Do yourself.

Research Project

Refer to Text book Page No. 55, 56.

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 6 — More on Adobe Photoshop CS6

EXERCISE

A. Fill in the blanks.

1. Alt  2. Transform  3. Drawing  4. 25  5. opacity  6. black

B. Write T for true and F for false.
1. T  2. T 3. T  4. F  5. T

C. Match the following columns.

1. — d   2. — e  3. — a  4. — f  5. — c  6. — b

D. Answer the following questions.

1. We can copy a part of image to some another location in same image
using given steps.

l Open the concerned image where you have to do the copy operation.

l Select an area using the Marquee or the Lasso Tool.

l Select the Move Tool from Tools panel.

l Press the Alt key and drag the selected part with holded key. Selected
part will be copied to another location.

2. A brush in Photoshop can be up to 999 pixels wide.

3. Often we are required such shapes that are used in regular ways for
various purposes such as tick mark, scissor, copyright symbol and
animal paw, etc. These are drawn using Custom Shape Tool in the
form of preset shapes.

4. we can select a foreground and background colour using Color Picker
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Tool. Upper box shows the currently selected background colour
while lower box displays the background colour. The default
foreground colour is black while default background colour is white.
The painting, filling shapes and drawing strokes (lines) are done using
the foreground colour. The erased areas of an image are filled by
background colour.

5. A gradient uses two colour's mixing for making a blend and fill this in
object as a colour. Gradient Tool fills gradient in a part of object as
selected or complete layer. Gradient types are Linear, Radial, Angle,
Reflected or the Diamond.

We should follow given steps to use Gradient Tool.

l Open image file where you have to use the Gradient Tool for
gradient fill.

l Select the area of image where you have to use the gradient fill by
using any selection tool.

l Select the Gradient Tool.

l Click on Gradient sample box in the Context menu. The Gradient
Editor dialog box will be appeared.

l We can use a readymade gradient by selecting a preset gradient
fill or you can create a new gradient fill in the Gradient Editor
dialog box.

l Click on the OK button. Now you have created or accessed a
gradient fill to use.

l Select the desired gradient type in the Context menu.

l Now take the mouse over the selected area and place it where you
want to set the start point of gradient and drag it to define the end
point.

6. We can write the text in different styles and shapes. It is referred as
warping text.

Research Project

Spot healing brush tool :

It quickly removes blemishes and other imperfection in your photos. It
works similarly to the healing brush. It paints with sampled pixels
from an image or pattern and matches the texture, lighting,
transparency and shading of the sampled pixels to the pixels being
healed. Unlike the healing brush, the spot healing brush doesn't
require you to specify a sample spot. The spot healing brush
automatically samples from around the retouched area.

In the Lab

Do yourself

For Teachers

Do yourself

Chapter 7 — Visual Basic

EXERCISE

A. Fill in the blanks.

1. Visual Basic  2. event driven  3. design  4. code  5. Label  6. F5
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B. Write T for true and F for false.
1. T  2. T 3. F  4. F  5. F

C. Match the following columns.

1. — b   2. — f  3. — d  4. — e  5. — a  6. — c

D. Answer the following questions.

1. Microsoft developed Visual Basic in May, 1991. Beginners prefer
Visual Basic due to its easiness. Visual Basic is also liked by
professionals due to ease of developing softwares. It provides you a
Variety of tools to create applications in desired way matching all real
world situations. Visual Basic is a third generation event driven
programming language and Integrated Development Environment
(IDE). It makes application with higher user interaction which
consists of toolbars, menus, command buttons, dialog boxes, icons
and pointers, etc.

2. In event driven programs, the statements are not executed in the same
sequence in which they are written. They only get executed when a
corresponding event occurs.

3. A Visual Basic program can be made in three modes for different
purposes. These are as following.
Design Mode : In this mode, a program is created. Various tools and
objects are initiated here and logical statements are written for
desired events. Programmer plays an important role in design mode.
Run Mode : In this mode, the created program is run by end-user
and application executes. It performs the tasks for which it has been
programmed.
Break Mode : A program may not give desired results in some
situations or it may be erroneous also.

4. Solution Explorer : This window displays a list of forms and other
objects that constitute the application. This list is organized in the
form of a branching structure like Windows Explorer. To open any
object, we can double-click on its icon in the Solution Explorer
window.

5. Properties are the attributes that defines the appearance and
behaviour of objects (forms and other Controls). Forms have many
properties such as Name, Font, Color, Border Style, Padding Size,
Text, etc. Properties window is used to set the properties of forms and
other controls placed on them.

6. Text Box is box like shape and it is used for getting the input value
from user. Text and numbers both type of values can be entered in
Text box control.

Name–The Name property identifies a text box while writing the
program.

Text–This property contains the text which is displayed in the text
box.

Research Project

Refer Text book on chapter 8 for answer.

In the Lab

Do yourself

For Teachers

Do yourself
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Chapter 8 — More on Visual Basic

EXERCISE

A. Fill in the blanks.

1. Images, Graphical  2. Normal  3. VB Script  4. Dim  5. \  6. OR

B. Write T for true and F for false.
1. F  2. T 3. F  4. T  5. T

C. Match the following columns.

1. — c   2. — f  3. — d  4. — b  5. — a  6. — e

D. Answer the following questions.

1. We can add the image in a VB application too. Image control, i.e.,
Picture Box control is used for this purpose. It shows a rectangular
boundary after adding it to form. We should use the picture property
for specifying an image.

2.

Size Modes Description

Normal This is a default size mode of Picture Box. In this mode,
picture is positioned in the upper-left corner of the
Picture Box and any part of the picture that is too big for
the Picture Box is clipped.

Stretch Image This size mode is used to stretch or shrink the picture as
to fit to the Picture Box.

Auto Size This size mode automatically resizes the Picture Box to fit
the picture.

Center Image This size mode displays the center area of the picture in
the Picture Box.

Zoom This is used to stretch or shrink the picture to fit in the
Picture Box. However, the aspect ratio in the original is
maintained as it was.

3. It is advised to users that they should declare the variables in explicit
way. It is referred as explicit declaration. For making it, user should
use Option Explicit before declaring the variables.

4. Logical operators are used to combine two or more conditions and
result is evaluated according to the various combination of conditions.

5. If... Then... Else Statement

If statement is used for making decisions based on comparisons. If the
conditions is true then the statements written after THEN are
executed. In case of opposite result statements written after ELSE are
executed, i.e., the condition becomes false in this case.
Syntax : If <condition> Then

VB Statement (s)

Else

VB Statement (s)

End If

6. For Next Statement is used to repeat a set of statements a fixed
number of times. A counter is used to count the number of executions
in this loop.
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Syntax : For <counter> = <Initial Value> To <Final Value>

VB Statements

Next

For example, if we want to display first 10 numbers then we
will write the following statement.

For Print Num = 1 to 10

Next

Research Project

Do yourself.

In the Lab

Do yourself.

For Teachers

Do yourself.

Chapter 9 — Understanding HTML

EXERCISE

A. Fill in the blanks.
1. Internet  2. IBM  3. Opening (<), Closing (>)  4. 64 5. Empty

6. Attributes
B. Write ‘T’ for true and ‘F’ for false.

1. T  2. T 3. F  4. F  5. T
C. Match the following columns.

1. — c   2. — d  3. — e  4. — a  5. — f  6. — b
D. Answer the following questions.

1. Internet is critical part of human life due to its usage in all areas of
human life such as education, entertainment, industry, job, sports and
market, etc. Internet is a medium by which human can share the data
and information across the globe instantly. The servers share their
data and information resources available on the Internet with the
clients. They rely on servers for files, devices, processing power, etc.

2. HTML is a complete code package that enables a user to create web
pages. It includes text and graphics. We can add links to your web
pages. Hyperlinks are the highlighted text segments or images that
connect a page to other pages on the web. Its fill form is Hypertext
markup language.

3. The <HEAD> is the first element contained inside the <HTML>
element. It contains no text within itself.

4. Heading tag is used to define different heading levels in the HTML
document.
There are six heading levels (H1 to H6). H1 heading style displays the
text in the largest size and is used for main heading, the text increases
to 24 pt font size. The lowest level H6 reduces the font size to 8 pt. The
lower levels are used for the sub headings and less important things.

5. Any text which consists of many lines should be enclosed with <P>
tag. <P> tag is used to make paragraphs in web page. A paragraph is
ended by </P> tag. A paragraph can be aligned with the help of Align
attribute. Various values used for Align attribute are as following.
Syntax : <P> It starts a new paragraph.

<P Align="Center"> It aligns the text to the center.
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<P Align="Right"> It aligns the text to right.

<P Align="Left"> It aligns the text to the left side.

<P Align="Justify"> It aligns the text evenly between both
left and right margins.

6. The bold tag is used when you want to emphasize the text. Type <B>
before typing the text which you want to display as bold and type
</B> after the text.
Example : <B> CYBERMIND </B>.

Research Project
Moving text can also be displayed on webpage using MARQUEE tag.
Syntax : <MARQUEE> (Moving Text) </MARQUEE>

The masquee tag comprises of many attributes such as width, height,
behavior and bg color etc.
Hyperlinks to other pages:
Links are specified in HTML using the <a> tab.
A link or hyperlink could be a word, group of words or image.
< a href ="url"> Text link </a>
The href attribute in source anchor specifies the address of the
destination anchor.

In the Lab

Do yourself.

For Teachers

Do yourself.

Chapter 10 — Advanced HTML

EXERCISE

A. Fill in the blanks.

1. Font  2. face value  3. Bg color 4. Unordered 5. ordered 6. MARQUEE

B. Write ‘T’ for true and ‘F’ for false.
1. T  2. T 3. F  4. F  5. T

C. Match the following columns.

1. — c   2. — f  3. — e  4. — b  5. — a  6. — d

D. Answer the following questions.

1. Changing Type of Font : We can change the font type using FACE
attribute of FONT tab. Type FONT FACE = "Value" to perform it
where value reflects the name of the font; e.g., <FONT FACE =
"Cooper Black">.

Changing Font Colour : The font color attribute is used to change
the font colour of the text. The colour can be set by providing colour
name or colour code as value of font colour attribute. Type <FINT
COLOR = "?"> before the text and replace "?" with colour name or
colour code.

2. We can change the background colour of web page using Bgcolor
attribute of Body tag. In the <BODY> tag, type BG COLOR = "?",
replacing? With the colour name or a colour code.
Syntax : <BODY BGCOLOR = "?">

3. The website should be designed by a person with a strong sense of
graphic design in order to make it visually appealing for the users.
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4. There are some more attributes of Body tag which are used to change
the top margin and left margin of web page. These attributes are
TOPMARGIN and LEFTMARGIN.

5. Unordered list is used when sequence has not so important when
describing points. The default bullet type for most of the browsers is
disc (small filled black circles), before the list of items. The list begins
and ends with <UL> and </UL> tags respectively.
The ordered list is used to create a list with listing items by numeric
values. By default numeric values are shown as sequence of ordered
list. But other sequential values are also used to shoe the items of
ordered list such as (A, B, C), (I, II, III), (i, ii, iii), etc.

6. Moving text can also be displayed on web page using MARQUEE tag.

Syntax : <MARQUEE> (Moving Text) </MARQUEE>
The marquee tag comprises of many attributes wuch as Width, Height,
Behaviour and Bgcolor, etc. Width attribute decides the screen width
in which moving text will be displayed. Height attribute will
determine the height of strip where message will be displayed.
Behaviour attribute decides the behavour of text, i.e., how will the
text be displayed. Bgcolor attribute decides the background colour of
strip where moving text text will be displayed.

Research Project

Creating a table :

The basic structure of an HTML table consists of the following tags :

Table tags : <TABLE> </TABLE>

Row tags : <TR> </TR>

Cell tags : <TD> </TD>

Constructing an HTML table consists of describing the table between the
beginning table tag, <TABLE>, and the ending table tag </TABLE>.
Between these tags, we then construct each row and each cell in the row.
We would first start the row with the beginning row tag <TR>, and then
build the row by creating each cell with the geginning cell tag, <TD>,
adding the data for that cell, and then closing the cell with the ending cell
tag, </RT>. Then for each new row, we would repeat the process of
beginning the row, building each cell in the row, and closing the row.
Image as hyperlink : We can make image hyperlinks. This is done by
replacing the hyperlink href anchor text with some HTML image "ing" code

<a href = "html – image - hyperlink.php">

<img src = "images / sample - image.jpg"

title = "Example image link" width = "600"

height = "400" /> </a>

In the Lab

Do yourself.

For Teachers

Do yourself.

Chapter 11 — Introduction to C++

EXERCISE

A. Fill in the blanks.

1. high  2. constants  3. Modulus 4. Variables 5. Header files 6. Cout
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B. Write ‘T’ for true and ‘F’ for false.
1. T  2. F 3. T  4. F  5. F

C. Match the following columns.
1. — f   2. — c  3. — e  4. — b  5. — a  6. — d

D. Answer the following questions.
1. C++ was developed by Bjarne Stroustrup in the early 1980s at ATL &

T Bell Laboratories.
2. l An identifier consists of only alphabet, digits and/or underscore.

Any other special character is not allowed.

l It must not start with a digit.

l Uppercase and lowercase letters are considered different.

l It should not be a reserved word.

3. Operators are symbols which are applied on variables, i.e., operands
for specific purposes. Various types of operators are listed below.

4. Relational operators are used to compare two values. These operators
always return TRUE or FALSE on the basis of condition.

5. Variables are used to store values in memory locations of computer.
These provide meaningful names for this purpose such as num, val,
average, cust-id, etc. Each variable should be of a specific data type so
that it can access and store the value of its specific domain such as
char, int, float, etc.

6. Structure of C++ Program

Research Project
# include <iostream.h>
# include <conio.h>
void main ()
{
int num;
clrscr ( );
cout <<"n Enter a numbers:";
cin >> num;
if (num % 2 = = 1)

cout << "/n num is odd";
else

cout <<"/n num is even";
getch ( );
}
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# include <iostream.h>
..........................................
void main () Main Function
{ Opening of a Program
..........................................
.......................................... Main Body of a Program
..........................................
} Closing of a program

Header Files Section



In the Lab
# include <iostream.h>l

# include <conio.h>
void main ( )
{
char name [50];
int age;
char school_name [100];
cout <<"/n Enter your name";
cin >> name;
Cout <<"/n Enter your age";
cin >> age;
Cout <<"/n Enter your school name";
cin >> school_name;
cout <<" your name is :" <<name;
cout <<"/n your age is :" <<age;
cout <<"/n your school name is :" <<school_name;
getch ( );

l # include <iostream.h>
# include <conio.h>
void main ( )
{

char name [50];
cout <<"Enter your name" ;
cin >> name;
cout <<"My name is" <<name;
getch ( );

}
l # include <iostream.h>

# include <conio.h>
void main ( )
{

Clrscr ( );
cout <<"/n +" ;
cout <<"/n – – " ;
cout <<"/n * * * " ;
cout <<"/n / / / / " ;
getch ( );

}
l # include <iostream.h>

# include <conio.h>
void main ( )
{

int num 1, num 2, num 3;
clrscr ( );
cout <<"Enter first number";
cin>> num1;
cout <<"Enter second number";
cin>> num2;
num 3 = num 1 + num 2;
cout <<"Sum is" << num 3;
if (num 3 % 2 = = 0)
cout <<" sum is even";

else
cout <<" sum is odd";
getch ( );

}
For Teachers

Do yourself.
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